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I —E BT BRI X (FEE: 1T S7-400 PLC %A 3E 5% kMt RAM, B84 T84
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1) 47E step7 AT T (download) I, Zx3tigmfRut s P FET F2EE] CPU 2E#;
TR IX,  [FIB 3Eas AT I R RS 7 A 5 N TAEAF B X (40 OBL A dE ).

2) # CPU &G4, MRGWHN, TR T RIS SR PS5
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2. S7-300 CPU K436 = =

8 CPU [ skfifikdeksr2: #ifl S7-300 CPU. #rfEf S7-300 CPU. A E EPROM [f)
S7300 CPU, HAHHRLIT:
2.1 ¥ S7-300 CPU

H S7-300 CPU 2R H MMC R AE N HAEHA7 i 45 1) CPU, LK CPU A 2235 J5 4 v ith, o 4t

1. BT HA S7T300-CPU BAE W E MR fFitds, FULLAUEH MMC +. #ifif) S7-300 CPU
AFFEER (R CPU3IXC HRAN)HIHFRAER BT CPU. AR T I T #8007 N BRI =,
A MMC &, ZIGEEREF F#HE CPU H i,

WA ERTTTFH CPU LM AUEMFTTT LMK MMC =, AREMEHEGRIAENL. #2H1EE PDA
SRR P A AR MMC £ . B AT T BL R LR PLC 77 s

s = A R
6ES7 314-1AF**-0ABO i CPU 314
6ES7 315-2AG**-0ABO #A CPU 315-2DP
6ES7 312-5BD**-0AB0 CPU 312C
6ES7 313-5BE**-0ABO CPU 313C
6ES7 313-6CE**-0ABO CPU 313C-2DP
6ES7 313-6BE**-0ABO CPU 313C-2PTP
6ES7 314-6CF**-0ABO CPU 314C-2DP
6ES7 314-6BF**-0ABO CPU 314C-2PTP
6ES7 613-1CA**-0AE3 C7613
6ES7 635-2EC**-0AE3 C76350P

6ES7 635-2EB**-0AE3 C7 635 OoP



6ES7 151-7**-0AB0 ET200S with CPU
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2.1.1 A T# & S7-300 CPU # MMC &

MMC K& —F FEPROM £, FITF#iAM S7-300 CPU, ISR CPU Al AR E R 557 (1035
R CPU. ¥ CPU %A W E FIEHAM8:, LAUEH MMC RAE NS 37 88 (- A7 F P Bl
CPU fHIRF, 2> 0¥ TR B HEHE DL MMC {717 DB Juidfs . W& 8-1 Ak
MMC = 5 2 H AR F2 7 K/ BT B, s B @& WoRkF CPU TfEW 4, CPU313,
CPU314,CPU315-2DP,CPU317-2DP #%I| CPU KA {fithk MMC K& K3 H 8 MB , HAthfx =iz #F 4
MB
F-T3#i 8 S7-300 CPU ] MMC < (Micro Memory Card ) 24541 F
64 KB 6ES7 953-8LF11-0AA0
128 KB 6ES7 953-8LG11-0AA0
512 KB 6ES7 953-8L.J11-0AA0
2MB 6ES7 953-8LL11-0AAQ
4MB 6ES7 953-8LM11-0AA0
8 MB 6ES7 953-8LP11-0AAQ
e DUE= T B 5 S RO i R AR R T A R B, 7 R DL A4 RO T
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f#FIMMCIICPUASFC 82, 83, 84%45tt, wl LIHT ¥ s .

< SFC82“CREA_DBL": 7E3:# N 17 (Load Memory) /A= it

<~ SFC83“READ_DBL": #3# N7 (Load Memory) H {4

< SFC84"WRIT_DBL": H¥i#litk (N%) 2 A4 (Load Memory) BIMMCEHi.

B2, BHERHTMMCRESSANIREGRAREK, B2 HSFC 84 MMC-K 5 #dfif
B RAEAR R 1 RIS (B /N, R )V W SRMMCR AR A7 K 2B i, AR
FIH S R M e Mg, A ERF MR EME (RET_VAL) H. &1l sRIECPUR2
Wz X

KTSFC 82, 83, 84 I & WK “MMCREHE 15",

RSSERE:  http://www.ad.siemens.com.cn/service/e-training/detail.asp?attachmentid=183.

2. AhFEgmE, o A L .
24 A R B V60 CIY, 2 MMCHI i HI A7y, 0-60 CHITLAEMEL T, MMCRH AT MR/
5  #:{£100,000/K
3. MMC R/™AET5 iR . 55 U AE VORI 46 N HREDIZ oo 5 AR I S ( R RIR
4. —HERAMEBEBLAL S HIER MMC &
1) AL PRI SR I H
2) 447 “copy RAM to ROM” i 2 SR T F .
3) UALEfEAS AL H ISR AR %
4) AR A EUE A REIEAT
5) MH TR MMC K& 80, R A, MR RAIR.
HEE: MMC RHBEEATET T PG ST L AMERE (prommer) #ETHE b, A3
B ST IR AT R AR SR AR R R

2.1.3 WTREFEAN MMC
MMC #&#i ! CPU FME—BE B A7 2%, ARMIAE R P05 R B R AA R R .
NEEEA W LR

1. HEFH: H%‘H%%%W@T%ii%é@ B N, BEH STEP7 Fi{“PLC >“Download > #
A T, (nE8—2)



QSIMATIE Manager - [tt -- C:\Program Files'Siemens"Step 7' s7projitt]
% Eile Edit Insert | PLC Miew Options Window Help

Dlﬁl g?lﬁl [ Access Rights 3 p! < fo

=8 @ .
=F STMATIC 3 Configurs Chr|HK

EI cpu 311l Eempile and Downlead Ohjects, ..

=50 57 Upload be PG
.@ Upload Station ko PG,

Retrieve fra

[Manage ME Systen, ..

Display Accessible Nodes

SR Rl

K 8—2

2. fH STEP7 #J“PLC >“Download User Program to Memory Card”Z B.fy 2K BEAFEF T

B 8—2), VERAEM LN AR N ESEAEE TR, RAREAA T, A2
MMC R H SR 2T B . IR E A T FEPROM .

ffiff] STEP7 H/{“PLC >Copy RAM to ROM” (tE 8—2) a4, LB LIEAFEasH
NZEHE DLE] MMC R, [T 208 MMC R SR IO 2075 FR . bR {E HEE & CPU 7£ STOP £t
R A REAT . XAMEAH T4 CPU 2 iTiz1T1H 40 DB BRIz 4T {E#% )L %) FEPROM K,
XEE XN MRES SAL, DB B & BACNRF M. tEiREX T FEPROM RFEFEA
4§/ PG I A] LU STEP7 F1f)“File > S7-Memory Card > Open” 3ZHidr4 (WK 8—3) 7T
JF#E%E, HH“PLC > Save to Memory Card "¥SC#F5 N MMC. it J5 3% 8 7 £ T
FEPROM k.

HSIMATIE Manager - [tt -- C:\Program Files'Siemens', Step 7' s7projitt]
27 Fle Edit Insert PLC Yiew Options Window Help

W e CHN  EWo Filter » jﬂl
—  Mew Project’ Wizard, .,
B open.., Ctri+o | Trpe
Open Yersion 1 Project. .. Station configur. ..
Close CPU
Multipraject 3

57 Merory Card

Za|zulate Checksum

Save As... Ctrl+5 Delete, .

Delete...
Rearganize. ..

K 8—3

5. {EREFFIEIL A SFC84“WRIT_DBL" (WIZE#fFfds S BHEYL, v LI TAEAEfil 2% 05U

B (R SNRBAEER (EiER)



2.1.4 WfTREE MMC RH KRR

] MRES 23 “Clear/Reset" A Refillk MMC =i, R aeMlbk TIEAF a3 N2,
HEALPAK MT,C LK DB HUNShri. FEE LG A3 MMC R iR #5 D3 TAEAE
figa
0 N7 AT LA B MMC R Hh £
1. /] STEP7 Hiff)"View > Online” 3¢ %, fE£ATIT Blocks, L ZMHERIKEL, H“Delete”

G, EURTEHEMIRR R AR X RALT RAM R
2. Fi“PLC >Download User Program to Memory Card” (i1 8—2) &M HEF.
3 AEHVEIT T A ds PG Hiih [ % H L RE R MR s AT # Ak .

2.1.5 MER MMC RAHRIEFRRIRIEN: $EhikRib

FERAMEBUH IS, A 0] e o R AT 1 2k 21k
1) AR AR 4 BT A v
2) [ MMC 5 $da i b -4 o i o
3) R I AS S SR ) B A B AN AR A
4)  ~Hf CPU i IER IR A HE
A ASATHE A A AR 8 CPU 1) STOP JTHIBUZIN, X/ CPU TEE R sk b, RA
BEEF AT B MRES #2414% 20k MMC &, JER iR (S BOE R, HURERAE 7RI T
AT RALF] MRES JHRFFEE] STOP AT IRFFH 5 (LI, FREHE =0 N IE IR S
TR, BIFE =P AR UTT SGIR 0] 3 STOP J& FHlV# k& [71 3] MRES A7 &, Ui, STOP AT PR (A4,
FORIEEME L. (REFIFOG/E MRES 11 B, HZF| STOP ATH 5%, &Nk 5Emk.
TR —EEFEANENEERF. SN, MMC MARBHTAR, TREEBF#ESREARSE.
XPEBRAE CPU B STOP TR KR, R—FMEskRie, EIEFEFAKER TILER
MRES # =4k MMC .

216 *TMMCEHHEREE

1. ®T MMC HAth ] @S % CR“MMC 15 B L E . i MMC KIFHZ, LA MMC
KB PLC BT A KT A R4S A) @

ZOCRS M hitp:/Aww.ad.siemens.com.cn/service/e-training/detail.asp?attachmentid=178

2.2 #tw#ER S7-300 CPU
FrifET S7-300 CPU 8 Z&AEH MMC £/ S7-300 PLC, R N2£301) S7- 300 CPU.



F&7 CPU318- 2DP 4b, HE ) CPU EAEHE. FriER S7-300 & N B 1 RAM 242
4%, FFATLMER FEPROM KRy i #ififkes. Hs, HA CPU 318-2DP wJ LAfi
RAM R 78 2307 1 2% -

2.21 FFH7ER S7-300 CPU ) FEPROM £

FrifERL) S7-300CPU A N B 1) Load memory , @it A\ FEPROM(Flash FEPROM) k¥ &
R AP ifds, Flash FEPROM R EZ R RAE NI F &40 . (BB J5 & il PLC 4518, 7£ PLC
FHJEHESHIN FEPROM £ # IFEFE] CPU [ TIEf 52+ . CPU318 HIfif4IX 5 ST7-
400CPU M8k, LAEFRM#3 7 NAF B AEREFR PR 48, 0 A7 it 4 A RS A A B, i R 4n
&l 8—4 fitn:

Flash EPROMfA R FHERFZEMNEA

“« L L] %ﬁ

)\ EPROM éﬂﬂash EPROM
T AT it 2
I\E

“g 0 ; = H 1 8
| > B i 3¢ 55 11
) < LT 5
“%?u PG’, |_ —-_

BRI K i

113468 4

THAHR
RAM

K 8—4

F-FFrER S7-300 CPU [f) Flash EPROM K (FEPROM )% 540
16 KB 6ES7 951-0KD00-0AAQ
32 KB 6ES7 951-0KE00-0AAQ
64 KB 6ES7 951-0KF00-0AAOD




128 KB 6ES7 951-0KG00-0AAO
256 KB 6ES7 951-1KHO0-0AAO0
512 KB 6ES7 951-0KJ00-0AAO0
1 MB 6ES7 951-1KK00-0AAO
2MB 6ES7 951-1KL00-0AAO
4 MB 6ES7 951-1KM00-0AAQ

e PLEFE ST IS S RS S T RS TR, R R DL A4 RO
2.2.2 RAETF CPU318-2DP i RAM F

128 KB 6ES7 951-0AG00-0AAO
256 KB 6ES7 951-1AH00-0AAO0
512 KB 6ES7 951-1AJ00-0AA0
1 MB 6ES7 951-1AK00-0AA0
2MB 6ES7 951-1AL00-0AA0

e DU AT B85 S B9 i R A ) TR A R R, R L A PO
22.3 W TKERFEA FEPROM &

1. £ STEP H{# ff]“PLC>Download User Program to Memory Card”>Z#.#54 (W& 8—2).
IRl PR R e R 8RS N FEPROM +, MANREE NREABE SRR P, F, FREA
W 2TE R ECRAEAE R IEER, RN RN E RAM XN .

2. f£ STEP # i “Copy RAM to ROM™54 (4nl& 8—2), w] LU TAELEM# I AN 245 Dl %)
FEPROM 1, [AIf 2K FEPROM R ERIINA R XMELHTIRMT PLC (1072
ITEFE ULE] PLC , XK NIRH] MRES 247, DB HHIME s & A N RAAE f{E. thI7i%b
[FIFEEH T MMC .

3. i} PG I 7] LAYE STEP $1# Fi“File > S7-Memory Card > Open"{] /I /¢t £ A  “PLC >
Save to Memory Card "###5 5 X FEPROM.IIAEXT MMC R AIFEG 2. 5 LA RS
T MMC <.

2.24 W% FEPROM R HFEFE

HAl, MEx FEPROM R HIREFHIATTINERG —F, #i2MH PG MR askMBR-F A%,
i FAE 38 AL TS R T
BN IR 7572 F R AT LA R FEPROM = H i) 4 25
1. 7£ STEP #{#i fH“Download user program to memory card "fir4 A LB T BHi% R4 5
FEPROM 1, HRAHIXA 4 MY, #iifkR FEPROM KA BLRT NIRRT 2 T



R KT TIEfA1# 28 KT FEPROM i %5 & I fd Hl“Download user program to
memory card"fy 2 I 2 HIAREE R, NEOIFRVIIR AT AR S:, (B2 T HGE UG 2 H IS =
58, PLC #RE)T5E, SR CPU KK {5 2 “Module information”t 7] LI ] FEPROM
RHARART, S TMER T REMRI, 250 DU R BN O R .

2. 7 STEP T f#i[l“Download user program to memory card” F & — M2 KFEF S F b, B
BRI

3. B AELMIBR TAEfEEA AR, FAE STEP H1#47“Copy RAM to ROM 4 Al LA
K FEPROM kA A 2 4l B Xt +&4 A EL [ EPROM () CPU I, Rl 7ok
Mk EPROM i % . (BUE ] T brifER S7-300 PLC)

4. M CPUMKEBSMRIE, EHEM TEMPGERN 82N ER RAM(load memory)H, 1t
IS} s £ BT L 2 AR sk 47 “Download user program to memory card” F#—4
FHREFRIEF, M ATER CPU L. 5 CPU MBS MY )5, $hir*Download
user program to memory card” M EINE T3] FEPROM K, WIEIE R IZ %,

5. fEHLRAE PG KMIBR. 7ERAoInE XK T %A% 50 6 H X BT VE R - A i

W2
225 %F FEPROM EHHEBEE

X hRER S7-300CPU, &Ik 5 B if R L HL, CPU #RaZRHUTE AL, Stop JT HIILE
N, FEH MRES 247 (J§ MRES EA0&: Sk RAE R R AT fE R R 35T ). X1 S7-400CPU
BRI G LREEERE LA CPU #IARERMATEAL, HEKR RS, TIEA#BNEFE3IE
%, HEA G & bl —FE.

2.3 #KE EPROM K S7-300 CPU

Xt A BB EPROM ) CPU #il, " LLfEFH“Copy RAM to ROM™¥ 72 J7 & il 3| 4 i

EPROM i, LABATRIERA & F b it o R AR M PR e sl A7 2 AL i AN £ k. CPU
312 IFM. CPU 314 IFM #il C7 %] 77 N &) EPROM 2872, HTARFEH, XEA
TR SR

3  RTHIERR

3.1 CPU @shh=:
S7-300CPU R AW 5" (Warm Start),{H CPU 318-2 DP /5577 1Al & XN B 3h(Warm

Start) #1745 3(Cold Start)HiFh, & CARE A s 5 HARARES S7-300 AHF], & CNREBIN, 5

S7 400 A B BAHE]). BEE3NHA OB100 H48. H)ashi, iR G SERIF R pERR. 4

WM G, IR — NG



CPU B: B3l

Properties - CPU314 - [R0/52)

armmUE At Em preEram g devees o Elinodes]

plet = IR i

f£ S7-300CPU ', “PowerOn->PowerOff's{ \"STOP-> RUN"W Fii 1 5t T & B 470 /& 2
(Warm Restart).
1. XA FEPROM RibR#HER! S7300 CPU:

1) A IE A IR B0

HURJEEhIT, )5 & AR R RAM 1744 3% (OB, FC,FB, DB) FIf {7 fBaE(M). & i 2%(T) A1t
HARC)HH R . R ARFE AL 28(M) BB 3 (T) R $8(C) . I FEMUG A AR 1 R
2) A G & H R B S B
IR RAM fE#28AH IR 4, e BRITEIER . RA € SURR R ALAAGE 2R (M) &
IS 33 (T) R HEC AR (C)RIEE B (DB (1 4t mT AR R K5 .



CPU @t {7

Properties - CPU314 - [RD/52)

Time-0f-Day Intenupts | Cyclic Interupt | Diagnogt 0 | Frotection |
General I Startup | Cycle / Clock kemory Fietentive Memary | Interupts

— Retentive Memory

Mumber of memary bytes from kMBD:

Mumber of 57 timers from TO:

1]

Mumber of 57 gounters from CO:

7~ | Areas

o

e aodiess o, of oytes
Retentive area 1:

Retentive area 2
12% QD%CPL{{Qﬁ Retentive area 2;
S % BRI 2 .

Retentive area 4:
Retentive area b:
Retentive area E:

Retentive area 7

TS
NN
LT

Retentive area 8:

Abbrechen | Hife

K9o—2

“LREF-ii#e"(Retentive Memory)in%s 51 FH K48 € T E R FFIALAAiEZR (M) ERTES(T) 1T
(C)F%EE: (DB) X, (Wk 9—2)

2. XTEH MMC REIHT AL S7300 CPU

R BT, FrA mAdiEse (DB) #BRBORFRN, “IREF/7i#E (Retentive Memory)brss BT &
XX N KO AT LR, W 9—38 Fras. &X T IRFFHFMHE (M) ERE(T). it (©
o B A R o AR UGN R R B



Properties - CPU 315-2 DP - {RO/52) x|

Interrupts I Time—of-Dlay Interrupts I Cyeclic Interrupts I
Diagnosties/Cloclk | Frotection | Communication
General I Startup I CyclefClock Memorsy Eetentive Memory
—Retentivity

Humber of Memory Bytes Starting
Humber of 57 Timers Starting with

Fumber of 5T Counters Starting with

| Areas
IE Ha.

Retentive Area Il_
Fetentive Area Il—
Eetentive frea Il_
Fetentive Area Il_
hetentive frea Il—
Fetentive frea Il—
Fetentive frea I]__
Retentive Area Il—

1 (|
L ¥ Cafcel

Kl 9—3
3.2 S7-300 CPU 7Efi#s & fir
MAFRER AL, TR AES. WEREEAZMHS TRl CPUY R LR KRB #bs i
B, SNEPATREARIR . G RAEERS RAEAE, FP R ARG 8 DB TAE Ak 28
AR AR S CAE I T
< MR TAREHSR T R - AR, AR R EEE (RESE MPI 2545 T)
> R RIAG AL
< X TR EPROM R CPU 4N | EPROM fififide R, H-RPAAAH R,
TEAHk #8 HALE CPU I EPROM [f) Py 2545 DUEI P TAEA7-f% X
PP MMC R CPU , fEAAiE#R A1 JE CPU A MMC RN DL RN ER AR
FEAHIX .
S WMREA AR, BER MPI HUEEGRER. (U, AURIEAIEE R, EBEA
KA MPI ik
< B IX N AEREE, %X 1 PR g A T O g
HE: WHTE CPU 4% L 7 Re AT Rt s EAL:
< BRI TSTOP A B 5L
> BRSO TRUN-PALE, 1@ E B 4:/E“PLC -> Operating Mode -> Stop” A4t
B #e %) STOP.

=

umber of Evtes

D
T
TITTTIT

5
o




3.3 #% S7-300 CPU(fE MMC ) K% R /&
1. fAfifds (M), ERER(T). tHEEs (O IR RFRIEIE T & S AR EF, Wit
AR, I Stop->Run k¥ Power offfon = A7, fnRAHE N{EEE, N Stop-
>Run 53 Power Off/On #4145,
2. DB #h#%&f#F:, A% Stop->Run ¥ Power offfon B FiA L4 A7 DB B ffifh -
L) KR BE-) - dER-) B

e BRSO AT VA
BRI A
25T % JEH/WHE | STOP->Run | f7fifgs &
A

PR (MMCH) X X X

B P ) SEpr e X X

REFIIMF s (M) SERFEH(T) TH¥Es (O X X

21515 2 e PN P A N e X X X
MPI bl AR X X X

X=tR#E —=JREF
3.4 3R S7-300 CPU (FRT CPU 318-2 DP) FRI%UHE LR :F A1 R :
1. i (ML R 3(T). HHEE (©
fAfEas (M) EREHT) THEER (C) BRI EREFEI TR GBS OREF, A SONFE
fREE, W Stop->Run (3% Power offfon ¥# A, WIRPHAZT NIRFF, W Stop->Run 2#
Power offfon B8 /5F, NEA LRI, HVERE, JoHibl, LAEA FEPROM P&, &,
HEER,
2. ¥tk DB
Stop->Run: Jiifi DB {ifF, AEREBAREE
Power Off: A HItES, BT DB IREF, NEREVNREE
PGS RS TF
2 DB Heifi e SONAEDREE, M AL
2 DB Hetf e SONPRFR,  MIEE R AF

FEAE AR X LI



BERS AR
e R Ul W/ | STOP- htds AL

>Run

H PR EdE (FEPROME)

B (CPUi I, HNIREF)
HEdh (CPUAN A £, WD
HiEde (CPUANTTHIMAG &, RIEHR

X
)
REFIEAE S (MDL ERER(T). THEE « «
©

LW IX . IsAT /N R
MPI Hudil . A nE 2
X=frE —=FER¥HF

4 HWHHEREX

IEC: International Electrotechnical Commission, [E 5 TH RZE 24>,

FAQ: Frequently Asked Questions, & U in] @ fif 25 .

RAM: Random Access Memory , FEHLEEUTE (% 28,
B R RS ERNE, B ERIZ. R AMEZINENAEFRAERUS Sl N s .
TR R DL 5 MR il s A e O B A A el . B e ), R A Mt i Bdle it 2
ZRo R AMEREF R I N AF 847K . R R IB H 2 R A M.

ROM: Read Only Memory RAAig#s(—R BN, REELH).
RAM I ROM AL, 1 (185 K X 52 RAM 7EWT i DL JS (R A7 76 T 8 2 B sl ok, i
ROM A 4s. ROM X7y — kLML SLHEBR A AR E S PR A, R O MZ#Ea=sim, H
KAFAE AR VAR, ik SEHLH 4 1) BIOS #t2 R H 1) ROM.

PROM: Programmable Read-Only Memory, 7] i £ H 347 i 2% .

RAVFE NI, BT LA R O — A g R A7 % 4% (One Time Progarmming ROM,

OTP-ROM).
EPROM: Erasable Programmable ROM, A 2[4 ] 4 F2 R i 6k 2% .
AIEGERAE N, MR DI T AT R N 2, R BT AT E A .

EEPROM : Electrically Erasable Programmable ROM, Hi, FJ 45 4 7] i f5 R i A0 2e
ERRAMR AR B EE SER, THBESEA.



FEPROM: Flash EPROM , N {7 1] #[5 v] 4 f5 R A7t 25 -
)R T EEPROM ISt =i, BT INAE R AT AZE AR EAARARAN, BT AR RAETFHL. £
FHBL. 2 B, MP3 & B3RS T2 M. a1 H TSR T CF & (Compact Flash).
SD £ (Secure Digital Memory Card). ZJEIic{ZH# (Memory Stick) 4.
MMC: Micro Memory Card , 7 fEfEF .
B FEPROM F, EZETP]7#H% S7-300CPU K &% % S7-300CPU Hi(f1 CPU31xXC).
Hig AT FHIRIEAE A MMC RAREH T T7 1 CPU H, 2 a7 - MMC K.
PG: Programming device, P[] 4ifies.
PG5 S TS P ] T DRERE (ln STEP7,Wince 28), 425k CP5611 £ 1, H &5 MMC il
EPROM 4% I PC #l.

5 MRAXREEFTRHS
5.1 i+

® fHTH# S7-300 CPU ] MMC (Micro Memory Card )
MMC 2270 Be 1 BTt

S BT FiT 55
64 KB M41ifit & 6ES7953-8LF20-0AA0 6ES7953-8LF11-0AA0
512 KB flf#fiti = 6ES7953-8LJ20-0AA0 6ES7953-8LJ11-0AA0
2 MB flfEfifi~ 6ES7953-8LL20-0AA0 6ES7953-8LL11-0AAQ
4 MB PfifiE & 6ES7953-8LM20-0AA0 6ES7953-8LM11-0AA0
128KB 117 fiti 6ES7 953-8LG11-0AA0
ERED:

128 KB ] MMC iR/ BUBN 1T 5255 URTIIT 55 98 A 2 (6ES7953-8LG11-0AAQ).
A
i MMC R 5288 A (1 MMC -RAEDDREA £ 18 b 2 A .
® i THr#E® S7-300 CPU ) FEPROM
16 KB 6ES7 951-0KD00-0AAQ
32 KB 6ES7 951-0KE00-0AAQ
64 KB 6ES7 951-0KF00-0AAQ
128 KB 6ES7 951-0KG00-0AA0
256 KB 6ES7 951-1KH00-0AAQ
512 KB 6ES7 951-0KJ00-0AAQ



1MB 6ES7 951-1KK00-0AAO0
2MB 6ES7 951-1KL0O0-0AAQ
4MB 6ES7 951-1KM00-0AAO

® JfI-T S7-400 CPU J FEPROM
64 KB 6ES7 952-0KF00-0AAD
256 KB 6ES7 952-0KH00-0AA0
1MB 6ES7 952-1KK00-0AAQ
2MB 6ES7 952-1KL00-0AAQ
4MB 6ES7 952-1KM00-0AAQ
8 MB 6ES7 952-1KP00-0AA0
16 MB  6ES7 952-1KS00-0AAQ
32 MB 6ES7 952-1KT00-0AAQ
64 MB 6ES7 952-1K YO0-0AAQ

® T S7318-2DP ] RAM .
128 KB 6ES7 951-0AG00-0AAD
256 KB 6ES7 951-1AH00-0AA0
512 KB 6ES7 951-1AJ00-0AA0
1MB 6ES7 951-1AK00-0AAQ
2MB 6ES7 951-1AL00-0AA0

® /T S7400CPU () RAM &
64 KB 6ES7 952-0AF00-0AAD
256 KB 6ES7 952-1AH00-0AA0
1MB 6ES7 952-1AK00-0AAQ
2MB 6ES7 952-1AL00-0AA0
4MB 6ES7 952-1AM00-0AAQ
8 MB 6ES7 952-1AP00-0AAQ
16 MB 6ES7 952-1AS00-0AA0

® [HT¥ JE S7417-4 CPU [ T/EAEHE 78It RAM
2*2M B6ES7 955-2AL00-0AA0
2*4M 6ES7 955-2AM00-0AAQ



5.2 USB iF#

i F USB 2R 4% 1] g AL BT & FEPROM 174K LA & MMC &

Product Designation

Order No.

USB Prommer

6ES7 792-0AA00-0XA0




